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OVERVIEW

This document was written for all audiences with its main purpose being to illustrate the second
set of steps required to get AccuMap up and running after it is installed for the first time. For
clarification purposes, the term “AccuMap” refers to accu32.exe, which the end user sees as an
AccuMap icon (shortcut) on the desktop after running an AccuMap workstation setup.

It is divided into two parts. PART 1 — INTRODUCTION provides a background on the AccuMap
License Manager Service and the AccuMap License File. It explains what they are, where they’re
located, and how they interact.

PART 2 — INSTALLATION deals with the installation of the AccuMap License Manager Service
itself. However, because the process takes place in the Windows command prompt, it's divided
into SECTION A — ACESSING THE INSTALLATION DIRECTORY, which details how to open
and navigate this component, and SECTION B — RUNNING THE INSTALLATION COMMANDS,
which details the actual installation commands and what is required afterward.

If you need additional assistance with this procedure, contact the Calgary Customer Support
department at (403) 770-4500 or e-mail support.cdn@ihs.com.
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PART 1 — INTRODUCTION

The AccuMap License Manager Service

The AccuMap License Manager Service is a service which helps to control access to AccuMap’s
data files by keeping a constant track of the modules in use and relaying that information back to
AccuMap for comparison against the total modules available in the license file. Failure to have the
AccuMap License Manager Service installed and running will prevent a successful start-up of the
software.

The installation files for the service are initially and most typically thereafter obtained by check
marking the SasPack component during the component selection of an AccuMap install (Picture
A). The folder may also obtained by contacting the Calgary Customer Support department.

Picture A (The SasPack component as seen on the AccuMap installation disk)

Select AccuMap Components {IPLIHSIPL) 5[

IF digk. space allows, click Select All. Othenwize, toggle which components o install.

T hiz component includes all
: executable program files.

Seizmic Data 203.4 MB

[w] Alberta Data 21066

Britizh Columbia D ata 3063 MEB

Sazkatchewan Data 4036 MB

td anitoba Data 328 B

Marthern Teritaries D ata G0.7 tB

| Mantana D ata 71.2ME x| Clear Al |
+|[w] Accubdap Executables SNIME | This component contains

v 'wiarkstation S etup 41.5MB Accumap licensing utilities.

Lizenze Manitar 0B

Help Files 12 5 MB
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Space Required: RA9GE
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The folder contains 11 program files and is only about 2.5 MB in size. The two files the installer
need be concerned with are sas.exe and sasnum.exe, which are used to install the AccuMap
License Manager Service and generate a serial number for the AccuMap License File
respectively.

Depending on whether a parallel or stand-alone installation of the AccuMap data and program
files was chosen, the SasPack folder gets created in either:

C:\IHSEnergy\AcculMap\v##.##\Setup\SasPack (Picture B)

Or
C:\IHSEnergy\AccuMap\Setup\SasPack (Picture C)
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Picture B (Default location of the SasPack
AccuMap data and program files)
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Picture C (Default location of the SasPack folder after a stand-alone installation of the
AccuMap data and program files)
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After its creation, the SasPack folder can be renamed and/or moved to another location, either on
the same computer as the AccuMap data and program files or on a different computer altogether,
so long as the computer it resides on is part of the network. R/W permissions to the SasPack files
and all its parent folders must also be granted to any account requiring the use of AccuMap.

NOTE: A common practice carried out by Field Support technicians during an on-site installation
is to move the SasPack folder to the root of the installation drive and re-name it “AccuLic” (Picture
D). Though this practice is not at all necessary for AccuMap to function correctly, it clearly
separates the service files from the data and program files, which can aid in any future
troubleshooting.

Picture D (The SasPack folder has been moved to C:\ and renamed Acculic)
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Once the SasPack folder is in place, the AccuMap License Manager Service can be installed
(See PART 2 — INSTALLATION). After installation, its status and path can be accessed through
the Windows Services panel (Start - Settings > Control Panel (Classic View) ->
Administrative Tools > Services) (Picture E). As previously mentioned, the service needs to
be running in order for AccuMap to successfully launch; a running service will have a status of
“Started” while a non-running service will simply have no status. The service’s path can be seen
by right clicking on it and choosing “Properties” (Picture F). The path of the service is required
for both troubleshooting and removal purposes.

Picture E (The AccuMap License Manager Service as seen through the Windows Services
panel)
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Picture F (AccuMap License Manager Service running from the default installation path)
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The AccuMap License File

The AccuMap License file (sssk.dat) is a small data file, which is accessed by both AccuMap and
the AccuMap diagnostics program (accudiag.exe) when AccuMap starts up. Within it resides
information required by AccuMap to determine what modules and domains it is able to access
and how many concurrent users are allowed to run. As seen in Picture H, the license file also
includes:

Company Name........... Name of the company the license was created for
Comment.........coevenes Generally used to differentiate multiple licenses for the same company
EXpiry...ccoooiiii Date the license will expire

LastUsed.............cee.eee Time stamp of when the last user in the company launched AccuMap
Serial Num.................. Authenticates AccuMap with the AccuMap License Manager Service
Application Num........... Indicates the network the license was created for; Microsoft Windows=0
Number of Uses........... Total number of times AccuMap has been launched by users

Semaphores enabled....Specifies whether AccuMap requires the License Manager Service in
order to start or access modules

Semaphore Type.......... Specifies the semaphore (i.e. set of permits) the License Manager
Service utilizes; always SAS (Semaphores AccuMap Style)

SAS Host.......cocevennis Tells AccuMap where to look for the AccuMap License Manager Service

SAS Port.....oveieennin Port the AccuMap License Manager Service uses to talk with AccuMap

Version Number........... Of license; increases as new modules or domains are added to AccuMap

Created.........cccevvvnene. Date the license was created

Release...........ccccceeent. Minimum release of AccuMap required for specified license version

Licenser........ccccoveenne. Person who created the license file

Picture H (A portion of the contents of an AccuMap License File)

Included are the license files from our AcoulMap setugs.
{licen=e file: 0:/Parallel Tnstall IPLIHSIPL/shared/sssk.dat)
Licensing file Informat-ion

- Comparoy Name: IHS

- Commerit : calhas03

- Expiry: Tha Oct 15 2002 (Z2009-10-15)

- Last TUsed: Twe Apr E8 2009 (Z009-04-28)

- Serial Mum: 1757194901 (Ox63BCRASE)

- Application Fham: u]

- Mamber of Uses: LEE3 5

- Bemaphores enabled: Tes

- Semaphore Type: Las

- BAS Host: 1040, 20, 1&

- BAS Port: Z 104

- Version Mmber: za

- Created: Fri apr £4 z0O03 (Z003-04-z4)

- Belease: Wol. 1% Mo. 03 [Fri Mar 13 Z00%] (EZ009-04-Z4)

- Licenser: Jim (Z)

Domains

Modules ALTA EC BASE MAN ET T TERR YT OMT T o i TEST
Base 20 z0 z0 10 u] u] 10 u] u] 10 10 10 u]
Tops =0 z0 z0 10 u] u] 10 u] u] 10 10 10 u]

NOTE: The license file is both a .DAT file and binary-based so it cannot be viewed in a text editor
such as Microsoft Notepad. Its contents can instead be seen through AccuMap via Tools > E-
mail License Files to IHS Support and reading the body of the message.
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The license file must be reside in one of two places for AccuMap to locate it. In a parallel set-up, it
should reside in the Shared folder (Picture 1). In a stand-alone set-up it should reside in the
Bin.Map folder (Picture J). The AccuMap License File is not “installed” as is the AccuMap
License Manager Service; rather, upon its receipt, it is simply saved to the correct location.

Picture | (sssk.dat located in the Shared folder in a parallel installation of the software; the
Shared folder contains other files but they are omitted here for clarity)
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Picture J (sssk.dat located in the Bin.Map folder in a stand-alone installation of the
software; the Bin.Map folder contains other files but they are omitted here for clarity)
& C: IHSEnergy"AccuMap’.Bin.Map
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If the license file is missing from its correct location, if it's named differently (i.e. sssk.dat.dat or
ssk.dat), or if the Windows user account launching AccuMap does not have R/W privileges to the
file, AccuMap will not start.

NOTE: Licensing for specific areas of AccuMap’s Air Photos layer and DST (Drill Stem Test)
Viewer is granted via the Valtus Ortho-Rectified Photographs License File (orthoarea.lic) and
Canadian Hydrodynamics Dataset License File (chdarea.lic). These files must have the same
set of permissions and reside in the same directory as the sssk.dat file.
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PART 2 — INSTALLATION

SECTION A — ACCESSING THE INSTALLATION DIRECTORY

Launching the Windows command prompt

NOTE: To install the AccuMap License Manager Service in Windows 2000 or XP, the user
account must belong to the Administrators Group. For help in determining your user account type,
see Appendix, Page i. In Windows Vista, if not logged in under the hidden Administrator
account, users must install the service with elevated privileges or it will display the message
“OpenSCManager() failed. Error code 5”, see Appendix, Page iii.

Service installation takes place in the SasPack directory accessed via the Windows command
prompt. In Windows 2000 or XP, from the Start menu choose “Run...” type: cmd and click “OK”
(Picture A). Windows Vista users click Start, type: cmd in the search box, right click on the cmd
icon it finds and choose “Run as administrator” (Picture B). Windows Vista users logged in
under the hidden Administrator account can simply left click on the cmd program.

Picture A Picture B
7
Run 21X s
Bl cmd
= Tvpe the name of a program, folder, document, or Open

Internet resource, and Windows will open it For vou, =
#  Run as administrator

Qpen: I cmd| j » Search Everywhere
! Search the Intemet

oK I Cancel | Browise. .. | a 0 S |

Help and Support

The Windows command prompt will open up in the user profile home directory; the exact path will
vary according to your operating system. In Windows XP, the user profile home directory is
C:\Documents and Settings\username, where username is the name you use to login to your
Windows account. In Picture C the username is jtb86516.

Picture C (The Windows command prompt opens in the user profile home directory)

WINDOWS  system32hcmd.exe

Microsoft Windows XP [Uersion 5.1_.2608681
CC» Copyright 19852081 Microsoft Corp.

C:“Documents and SettingssjtbhBb6516>_
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Navigating to the SasPack directory

Navigation through the Windows command prompt is done through user input commands. Type:
cd .. and press < ENTER > to go back a directory or type: cd directoryname and press < ENTER
> to go forward a directory. To change drives (i.e. from C to D) type: d: and press < ENTER >.

For example, a stand-alone installation of AccuMap places the SasPack directory in
C:\IHSEnergy\Accumap\Setup\SasPack (Picture D). So, from the user profile home directory of
C:\Documents and Settings\username, navigation would be as indicated in Picture E.

Picture D (The Saspack directory as seen through Windows Explorer)
& C:\ IHSEnergy' AccuMap’Setup'.SasPack

File Edt Wiew Favorites Tools  Help
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Folders x lﬂﬂaccumap_Iiu:ensing_cnnFiguratinn_guide.du:u:
| %5 accutool.di

D =k
/ earc

EI'

Folders

(E} Deskiop = ;ﬂ |
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Picture E (navigating to the SasPack directory through the Windows command prompt)

SOWINDOWS system32hcmd.exe

Microsoft Windows XP [Uersion 5.1_.26868]
(C>» Copyright 19852081 Microsoft Corp.

“Documents and Settingssjth86516>cd ..

~JDocuments and Settingsrcd ..

“IHE8Energyrcd accumap

C:
C:
C:»>cd ihsenerqgy
C:
C:~IHSEnergy~AccuMap>cd setup
C:

“IHE8Energy~AccuMap“Setuprcd saspack

C:~IHSEnergy~AccuMap~Setup~SasPack?>
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SECTION B — RUNNING THE INSTALLATION COMMANDS

Running sas.exe to install and start the service

If your computer’s IP address is dynamic follow OPTION 1. If it'’s static follow OPTION 2.

TIP: Your System Administrator or ISP will know whether your IP address is dynamic or static.
OPTION 1 (dynamic IP address): type: sas -install -altaddr 2 and press < ENTER > (Picture F).

Picture F (SAS installation for a computer with a dynamic IP address)
e CAWINDOWS system32' cmd.exe

C:~IHSEnergy~AccuMap“SetupsSasPackrsas —install —altaddr 2
AccuMap License Manager successfully installed.

Starting AccuMap Licensze Manager.

AccuMap License Manager started.

C:~IHSEnergy~AccuMap~Setup~SasPack>

OPTION 2 (static IP address): type: sas -install and press < ENTER > (Picture G).

Picture G (SAS installation for a computer with a static IP address)
e CAWINDOWS system32' cmd.exe
C:~IHSEnergys~AccuMapsSetupsSasPack»sas —install
AccuMap License Manager successfully installed.

Starting AccuMap License Manager.
AccuMap Licensze Manager started.

C:~IHSEnergy~AccuMap~Setup~SasPack>_

It should read, “Accumap License Manager successfully installed...” followed by “Starting
AcculMap License Manager” and “AccuMap License Manager started.”
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Running sasnum.exe to generate a serial number

After the AccuMap License Manager Service is installed and started you will need to generate a
serial number to be used in the creation of your AccuMap License File. Serial numbers are
generated by running sasnum.exe.

While in the SasPack directory, type: sasnum and press < ENTER >. It will then ask for SAS host
(Picture H).

Picture H (Generating a serial number to be used in the creation of your license file)
c \WINDOWS system 32 cmd.exe - sasnum

C:~IHSEnergy~AccuMap“SetupsSazPackrsasnum
zasnum [Uol. 1% No. 821

SAS host? _

If your computer’s IP address is dynamic follow OPTION 1. If it'’s static follow OPTION 2.

OPTION 1 (For a dynamic IP address)

For SAS host, type: localhost and press < ENTER >
For SAS port [default = 2104] press < ENTER >

It will now generate a serial number (Picture 1)

Picture | (SAS host & resulting serial number for a computer with a dynamic IP address)
\ZWINDDWS system32' . cmd.exe - sasnum

C:~IHSEnergy~AccuMap~Setup~SasPack>sasnum
zasnum [Uol. 19 No. 821

SAS host? localhost
SAS port? [default = 21841

Serial number: 2856524542 (Bx?YA?412FE>

Application number: @

Record these values and notify IHS Support at <483> 77804580,
or email them at support.cdnlihs.com

Press enter to exit this program.
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OPTION 2 (For a static IP address)
For SAS host, type: computername and press < ENTER > where, computername is the name of

your computer.
For SAS port [default = 2104] press < ENTER >
It will now generate a serial number (Picture J)

NOTE: For help in determining the name of your computer, see Appendix, Page ii.

Picture J (SAS host and resulting serial number for a computer with a static IP address)
W WINDOWS' system32', cmd.exe - sasnun

C:~IHSEnergy~AccuMap“SetupsSasPackrsasnumn

zasnum [Uol. 19 MNo. B2]

SAS host? CAL-Fi@71
SAS port? Ldefault = 21641

Serial number: 1555283268 (BxSCB3IBFF8>
Application number: @

Record these values and notify THS Support at (483> 7784588,
or email them at support.cdnPihs.com

Fress enter to exit this program._

E-mail the SAS host you used along with the serial number generated to either the IHS
representative you were working with or to support.cdn@ihs.com quoting your ticket number, if
applicable.

This information will be used to generate a valid AccuMap License File which will be e-mailed to
you shortly from the IHS Energy Licensing Department. Refer to PART 1 — INTRODUCTION,
The AccuMap License File, Page 6 for instructions on where to save your license file.

Close out of the Windows command prompt as you would any other Windows application.
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APPENDIX

Determining your Windows User Account type

To see if your user account is part of the Administrators Group, from the Start menu point to
“Settings” and choose “Control Panel”. Select “User Accounts” and locate your user name. If
you cannot open “User Accounts” without a password then you are not part of the
Administrators Group. In Picture A below, the user name jtb86516 is part of the Administrators
Group. Administrators can change the Group Membership of any account by highlighting the

account, clicking “Properties” and then selecting the level of access.

Picture A (The selected account is part of the Administrators Group)

2=

Users | Advanced I
IJse the list below to grant or deny users access ko waour
computer, and to change passwords and other settings.
U=sers For this computer:
User MName | Damain | araup |*
Adriniskrator CAL-F1071 Debugger Users, .,
7 asPiET CAL-F1071 Users
@-:I:ua ANanymaus CAL-F1071 Guests
; 16 Administrators
& lumac409 IHS Users
& lumaes4n IHS Users -
ﬁpedﬂﬁ#lS IHS Administrators ;I
add. .. REmove Propetties |

Password For jtbEa516

Change Passwaord,

@ To change your password, press Crrl-Alt-Del and select

Reset Password, ., |

o]

Cancel | Appli
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Determining your Windows computer name

To find the name of your computer, right click on the “My Computer” icon on your desktop and
choose “Properties” from the popup menu. From the System Properties dialogue box select
the Computer name tab to display full computer name (Picture B). It is not necessary to include
the trailing domain (if existing) in the entry for the SAS host. For example, the full computer name
may read CAL-F1071.ihs.internal.corp but only CAL-F1071 need be entered for the SAS host.

Picture B (The System properties dialogue box displays the computer name)

System Properties d S

Advanced | Autamatic Lpdates I Remate I
General Computer Marme | Hardware

. 3 YWindows uzes the following information to identify pour computer

1 ah the network.

Computer description; ||

For example: "Kitchen Computer ar "k any's

Computer'’.
Full computer narme; CAL-F1071 fihz. internal. corp
Dramair; ihz.internal. corp

0.

T o rename this computer or join a domain, click Change.

To usge the Metwark: |dentification *izard to join a Metwark [0 |
domain and create a local user account, click MNetwark =

Change...

k. I Cancel Apply
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SAS installation returns “OpenSCManager() failed, Error code 5”

Windows Vista has added a new security feature in the form of User Account Control (UAC). This
extra layer of protection commonly appears in the form of a “Windows needs your permission
to continue” dialogue box that pops up when users, including those who belong to the
Administrators Group, install programs or make changes that are administrative in nature.

While newer programs or programs updated for Windows Vista will display the UAC dialogue box,
prompting users to click “Continue” or “Cancel” before installation can continue, older programs
or programs not updated for Windows Vista may not. Sas.exe, the program which installs the
AccuMap License Manager Service, for example, will not display the UAC dialogue box but will
instead display the message “OpenSCManager() failed. Error code 5” (Picture C). Running
sas.exe under the hidden Administrator account or running the Windows command prompt as an
administrator is a way to avoid this issue (Picture D).

Picture C (SAS installation will fail if user account privileges are not administrative)

BN Command Prompt |ﬂlﬁj

C:~IHSEnergy~AccuMapsSetupsSasPackrsas —install
OpenSCHanager<) failed. Error code 5

C:~IHSEnergy~AccuMapsSetupsSasPacky

Picture D (SAS installation will complete if user account privileges are administrative)

=X Command Prompt |ﬂ|&]

C:~IHSEnergy~AccuMap~Setup~SasPackr»sas —install
AccuMap License Manager successfully installed.
Starting AccuMap License Manager..

AccuMap License Manager started.

C:~IHSEnergy~AccuMap~Setup~SasPack>_
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